
Individuals using assistive technology may not be able to fully 
access the information contained in this file. For assistance, 
please call 800-835-4709 or 240-402-8010, extension 1. CBER 
Consumer Affairs Branch or send an e-mail to: ocod@fda.hhs.gov 
and include 508 Accommodation and the title of the document in 
the subject line of your e-mail. 
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Section 1: Introduction 

Contents 

This section contains the following topics: 

Topic See Page 
System Background 2 
About this Manual 3 
Software Installation 4 
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Subsection 1.1: System Background 

Introduction The Food and Drug Administration (FDA) eSubmitter tool is a program that 
allows participants to electronically complete and submit information for 
various products to participating Centers. This tool is intended to automate the 
current paper submission process, allowing for quicker completion once users 
are accustomed to the software, as well as speed up the filing process with 
FDA. The eSubmitter software requires completing a series of questions in 
electronic forms and allows attaching documents, images and media files when 
additional information is needed. 

If using the eSubmitter software is not desirable, you may continue to complete 
hard copies of reports and applications, though for the reasons stated above, 
electronic submission is strongly encouraged. 
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Subsection 1.2: About this Manual 

Introduction The instructions in this manual provide detailed information for installing the 
eSubmitter software into a computer with a Microsoft Windows operating 
system. In addition, this user guide assumes familiarity with terms 
associated with using a computer (e.g. clicking and double-clicking). 

This manual is organized into five sections (including this one): 

• Section 1 provides an introduction and explains the requirements for 
running eSubmitter software, uninstall instructions, installation instructions, 
and proxy server instructions. 

• Section 2 provides instructions for starting the software, setting user 
preferences, and creating or reopening a submission. 

• Section 3 provides descriptive information about the eSubmitter software’s 
interface and toolbar. 

• Section 4 provides instructions for preparing a submission for completion, 
which includes entering information, saving submission entries or changes, 
and packaging submission files. 

• Section 5 FDA Recomended PDF File Specifications. 
• Section 6 FDA User Support. 

Please note that the screens used in this document are examples of what you 
might see while using the software. However, they may not appear exactly as 
shown. 

Note: The terms submission, report, and submission report are used 
interchangeably in this guide to refer to a submission report. 
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Subsection 1.3: Software Installation 

System • Windows Operating System 
Requirements • Adobe Acrobat Reader v5.0 or greater. 

• 30 MB of disk space 
• Access to a Compact Disk-Recordable drive (CD-R Drive) 
• Software capable of viewing Rich Text, such as a Web browser, 

Microsoft Word, or Adobe Acrobat (full install version, not the 
Reader) 

Uninstall Before installing eSubmitter, uninstall any other version of the software. 
Instructions 

Note: If you have a previous version of eSubmitter, be sure to save your data 
files and output files before uninstalling. If you do not have a previous 
version of eSubmitter, proceed to installing the current version of eSubmitter 
software. 

To uninstall a previous version of eSubmitter, follow the instructions below. 

Action Graphic 

1. Use Windows Explorer to navigate to the location of the 
eSub (versions may add suffix) file folder on the workstation. 

2. Delete the eSubApps file folder by right-clicking and 
selecting Delete. 

3. When the previous version has been uninstalled, you 
are ready to install the current version of the 
eSubmitter software. See the following procedure. 

Installation 
Instructions 

Installation 
Instructions from 
Web Page 

The eSubmitter software can be loaded from the internet or from a CD-ROM. 
The following two subsections will discuss instructions for each. 

The eSubmitter software is available for downloading from the web at 
FDA eSubmitter. To install the latest version of the eSubmitter software 
from this web page, follow the instructions below. 
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Subsection 1.3: Software Installation 

Action Graphic 

1. Click the link for downloading the eSubmitter 

Software and save the jinstall.zip file to your 

computer. 

2. Unzip the jinstall.exe file and double-click on the file 

to run the eSubmitter installation. 

3. Follow the instructions provided. Following the 

instructions, the software will be installed locally on 

your hard drive in C:\eSubApps\eSub. 

Notes: 1. You can change the location where the 

software is installed by changing the file path on the 

Installation Directory dialog box when it appears. 

2. The software may be installed on a network. 

eSubmitter has a file locking option that you set to 

prevent users from accidentally overwriting the work 

of another. For details, see Networking on page 18. 
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Subsection 1.3: Software Installation 

Proxy Server If you are using a proxy server to connect to the Internet, then you will 
Instructions need to change the application's properties file (eSubmitter.properties) 

to reference the server. See your System Administrator for help in 
changing the properties file. 

The properties file is located in the application's JExpress subdirectory 
(Program Files\eSub\JExpress). Add the following switches before 
the -cp switch: -DproxySet=true -DproxyHost=[proxy_host] -
DproxyPort=[proxy_port] (replace [proxy_host] and [proxy_port] with 
the appropriate information for your configuration). 

If the proxy server requires a user id and password, add the following 
two properties to the update.control file that is also located in the 
JExpress subdirectory: 

proxyUserName= 
proxyPassword= 
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Section 2: Getting Started 

Contents 

This section contains the following topics: 

Topic See Page 
Starting the Software 8 
Setting User Preferences 14 
Creating a New Submission 26 
Copy an Existing Submission to Create a New Submission 30 
Re-open an Existing Submission 33 
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Subsection 2.1: Starting the Software 

Introduction After you have successfully installed the eSubmitter software, you are ready 
to start up the application and create a new report. 

Starting the To start up the eSubmitter application, follow the instructions below. 
Software 

Action Graphic 

Start, and select Programs > FDA Submission 1. Software > eSubmitter. 
You will see a Registration Dialog box, as shown 2. 
below. 

Registration 
Dialog Box 

Click Next to continue the registration process. Or, 3. click Register Later to register at another time. If 
you click Next, you will see a Registration Dialog box 
asking you to enter your contact information. 
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Subsection 2.1: Starting the Software 

Registration 
Dialog Box: 
Contact 
Information 

On the Registration Dialog box, enter the information 4. requested. Required entries are indicated by blue dots. 
Click Next. You see a Registration Dialog box asking 
you to enter address information. 

Registration 
Dialog Box: 
Address 
Information 
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Subsection 2.1: Starting the Software 

5. On the Address Information dialog box, enter the 
information requested. Click Next. You see a 

Registration Dialog box to generate an email. 

Registration 
Dialog Box: 
Generate Email 

In the Generate Email step, you see a summary of the 6. information you entered. If the information is correct, 
click Next. If the information is not correct, click /
Previous until you return to the screen that you need 

to correct. 

Click Generate Email in the dialog box. You will 7. 
see an email. 

Click Send in the email. You see a Registration 8. 
Dialog box to check results. 
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Subsection 2.1: Starting the Software 

Registration 
Dialog Box: 
Check Results 

9. Select the button corresponding to either Yes the 

Email was sent correctly or No there was a 

problem. 

10. Click Done if the email was successful and to 
complete the registration process. 

11. Next, you will see the Intro Screen, which is described 

in the subsequent section. 
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Subsection 2.1: Starting the Software 

Intro Screen The Intro Screen provides an introduction to the software and will serve as 
your home screen. The Intro Screen will be displayed as shown below and 
the contents and tools available in the Intro Screen are described in the 
following table. 

Menu Bar 

Tool 
Bar 

Navigation 
Bar 

Menu 
Options 

Pane 

Message 
Tabs 

Primary 
Screen 

Area 

Function Icon Description 

Create New 
Submission 

Allows you to create a new submission 
entry. The New Submission Dialog box 
will appear. See section Creating a New 
Submission for more detailed information. 

Open an Existing 
Submission 

Allows you to open an existing 
submission. The Open Existing 
Submission Dialog box will appear. See 
section Subsection 2.5: Re-open an 
Existing Submission for more detailed 
information. 

eSubmitter Quick 
Guide 

Launches the eSubmitter Quick Guide. If 
the Quick Guide does not contain the 
information you are searching for, see the 
full length eSubmitter User Manual. 

Exit Application 
Closes the eSubmitter application. 
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Subsection 2.1: Starting the Software 

Help Topics Launches the eSubmitter User Manual. 

Forward 
Navigation Arrow 

This arrow allows you to move forward 
through the Message Tabs. 

Backward 
Navigation Arrow 

This arrow allows you to move backwards 
through the Message Tabs. 

Collapse/Expand 
Arrows 

Allows you to collapse and expand the 
Menu Options portion of the Intro 
Screen. 

Notification Stars The yellow stars are intended to notify 
users when new messages are available. 
The star appears next to the message tab 
header with new unread messages. 

Category 
Filter 

Allows you to filter the message 
information to display only generic 
information or those messages pertaining 
to a particular program. eSubmitter will 
remember the selected filter option upon 
closing and reopening the application. 

Mark as Read This checkbox enables you to indicate 
which message tabs have been read. Mark 
this checkbox to remove the yellow star 
shown next to the tab header. Unmark this 
checkbox to make the yellow star on the 
applicable tab header reappear. 
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Subsection 2.2: Setting User Preferences 

Introduction eSubmitter allows you to set preferences for the following categories: 
• Auto Save 
• Layout 
• Networking 
• File Location 
• File Viewer 
• Messages 
• Memory 
• MedDRA 

Setting preferences prior to creating a submission will make the process much 
easier. To begin setting preferences, click on the File Menu > Preferences. The 
User Pre ferences Dialog box will appear (as shown below). 

The subsections below will explain how to set preferences for each category. 
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Subsection 2.2: Setting User Preferences 

Auto Save Allows you to automatically save your report while you work. You can also set 
the interval for how often you want to save your report. At default, auto-save is 
automatically enabled and set to save files at 10-minute intervals. 

Note: The Blue Dot indicates that a response to the question is required. 

To change the auto-save option: 

Action Graphic 

1. Check the box to enable the auto-save feature (i.e., to 
turn auto save on) or clear the checkbox to disabled 
the auto-save feature (i.e., to turn auto-save off). 

2. If you cleared the checkbox, go to step 3. If you 
selected the checkbox, in the time interval box: 

Enter the interval (in minutes) for how often you want 
to save the file. 

OR 

Use the up and down arrows to select the interval. 
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Subsection 2.2: Setting User Preferences 

3. If you want to change or set the layout, click Next or 
the Layout tab. See the description for Layout 
below. 

OR 

If you are finished and satisfied with your changes, 
click OK to close the User Pre ferences Dialog box 
with your changes saved. 

OR 

Click Cancel to close the User Pre ferences Dialog 
box without saving any changes. 

Layout Allows you to set whether you want eSubmitter to open reports in the simple or 
expert layout when you start up the application. At default, eSubmitter opens 
reports in the simple layout. For more information, see descriptions in the 
Application Window section on page 35. 

To change the layout when eSubmitter starts up, follow the instructions below. 
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Subsection 2.2: Setting User Preferences 

Action Graphic 

1. In the initial layout box, select Simple or Expert from 
the drop-down menu. For more information on these 
layout options, see Subsection 3.1: Application 
Window, beginning on page 35. 

2. If you want to change the settings for networking, click 

Next or the Networking tab. See the description for 
Networking below. 
OR 

If you are finished and satisfied with your changes, 
click OK to close the User Preferences Dialog box 

with your changes saved. 
OR 

Click Cancel to close the User Pre ferences Dialog box 

without saving any changes. 
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Subsection 2.2: Setting User Preferences 

Networking Allows you to set file locking when using the software on a network. The 
application is primarily designed for use by one user at a time. However, in an 
effort to help support those that wish to run the application from a network, and 
to prevent users from accidentally over-writing the work of another, a simple file 
locking strategy has been incorporated. By enabling file locking, a user will be 
warned if the file that they are attempting to open is currently in use by another 
user. At default, eSubmitter opens without file locking. 

To enable file locking, follow the instructions below. 

Action Graphic 

1. Click to select the Enable File Locking checkbox (to 
turn file locking on) or clear the checkbox (to turn file 
locking off). 
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Subsection 2.2: Setting User Preferences 

Action Graphic 

2. If you want to change the settings for networking,
click Next or the File Location tab. See the 
description for File Location below. 

OR 

If you are finished and satisfied with your changes, 
click OK to close the User Pre ferences Dialog box 
with your changes saved. 

OR 

Click Cancel to close the User Preferences Dialog
box without saving any changes. 

File Location Allows you to change the location where your report data files are stored when 
saved and the location where files are generated when output (e.g., reports and 
packaged submissions). For more information on packaging files for 
submission, go to Package Files for Submission on page 92. 

To change the file location for each of the folders: 
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Subsection 2.2: Setting User Preferences 

Action Graphic 

1. Click the Select Location icon right of the text box. 

2. The Select File Location dialog box will appear. Click 
the Look In box, and navigate to the file folder where 
you would like your files stored. 

Select File 
Location Box 

3. Once you have navigated to the location, highlight the
specific folder and click Select in the bottom right-
hand corner of the dialog box. Your files will now be 
stored in the new specified location. 

Recommended Location: 
If installed on a Network drive (on Windows XP 
or earlier): The location of your data and output 
files will be contained within the eSub directory 
where the application was installed. 

If installed on a Workstation (on Windows XP or 
earlier): data and output files should be hosted in the 
following location: C:\Documents and Settings 
\eSub_Home\. 
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Subsection 2.2: Setting User Preferences 

4. If you want to change the settings for networking, 
click Next or the File Viewer tab. See the description 
for File Viewer below. 

OR 

If you are finished and satisfied with your changes, 
click OK to close the User Pre ferences Dialog box 
with your changes saved. 

OR 

Click Cancel to close the User Pre ferences Dialog 
box without saving any changes. 

File Viewer Allows you to identify the application that you will use as your PDF viewer. 
(Generally, Adobe Acrobat is used as the application for viewing PDFs.) 

Follow these instructions to set up your PDF viewer: 

Action Graphic 

1. Click the Select Location icon to the right of the text 
box. The Select Viewer Application File box is 
displayed (as shown below). 
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Subsection 2.2: Setting User Preferences 

Select Viewer 
Application File 
Box 

2. Click in the Look In box, and navigate to the file folder 
for Adobe Acrobat or the Acrobat Reader. The location 
is usually either: 

• Program Files > Adobe > Acrobat > Acrobat.exe 

• Program Files > Adobe > Reader > AcroRd32.exe 

3. Highlight (select) Acrobat.exe or AcroRd.exe and click 
Select. The File Viewer tab in the User Pre ferences 
Dialog box will appear in the text box as shown below. 

User 
Preferences 
Dialog Box 

4. Click OK. 
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Subsection 2.2: Setting User Preferences 

Messages Allows you to indicate whether you will receive missing data messages upon 
leaving a data entry screen. Allows you to indicate whether you will receive List 
Add/Navigation messages when leaving list screens. 

To enable these functions, do the following: 

Action Graphic 

1 Check the box on the right to enable Missing data 
messages 

To disable this function, check the box so that it is 
2. clear of any check marks. 

3. Check the box on the right to enable List 
Add/Navigation messages 

To disable this function, check the box so that it is 
4. clear of any check marks. 

5. Click OK. 
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Subsection 2.2: Setting User Preferences 

Memory Allows you to identify how much memory will be allocated when the application 
starts (default: 16MB) and how much memory will be made available, as needed 
(default: 128MB). 

To enable this function, do the following: 

Action Graphic 

1. To change the minimum memory allocated, use the
arrows to the right to increase or decrease or by
entering a number in the field. 

2. To change the maximum memory allocated, use the 
arrows to the right to increase or decrease or by 
entering a number in the field. 

3. Click OK. 
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Subsection 2.2: Setting User Preferences 

MedDRA Allows you to create a MedDRA of adverse event information. 

To enable this function, do the following: 

Action Graphic 

1. Select a Source File loction 

2. Select a Dictionary Output location 

3. Select Build Dictionary. Application will create the 
dictionary based on the source data 

4. Click OK. 
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Subsection 2.3: Creating a New Submission 

Introduction 

Create a New 
Submission 

This section provides an overview of creating a new submission report. 
Note: Before proceeding, make sure you have already reviewed the 
Introduction, Getting Started, and Interface sections of this user manual. 
These sections provide valuable information that is necessary in order to follow 
and understand the instructions in this section. 
There are two methods for creating a new submission report: starting from 
scratch with a completely blank report or copying an existing report and 
making the required changes. The purpose for copying an existing report would 
be to save time assuming many of the responses are the same. This might be the 
case if you have an existing report from the same product line or you are 
submitting a supplement. The steps involved for both are provided below. 

Follow the steps below to create a new blank submission from scratch: 

Action Graphic 

1. The eSubmitter application should be open on your 
computer desktop. If it is open, and you see the Intro 
Screen, go to step 2. (If it is not open, open the 
application first by following the instructions in 
Starting the Software on page 8.) 
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Subsection 2.3: Creating a New Submission 

Action Graphic 

2. Click the Create New Submission button from the 

Menu Options. Or you may select File > New or, 
click the New Report icon on the Tool Bar. The New 
Submission Dialog box is displayed (as shown below). 

Step 1. Select a Submission Type. The New 3 
Submission Dialog wizard is comprised of two parts. 
The first section (top portion of the window) requires 
that you select which Submission Type to create. 
When you click on the Submission Type, the bottom 
portion of the window displays information related to 
the corresponding submission type (as shown in the 
New Submission Dialog box figure above). 

Once you have selected the appropriate Submission 
Type, click Next. 
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Subsection 2.3: Creating a New Submission 

Action Graphic 

4. Step 2. Provide Submission Details (as shown below). 

Complete the fields on this dialog box as follows: 

• Descriptive Name – Enter any descriptive name, as 
long as it is unique to the submission list and not blank. 
Use a name that distinctly identifies the report to you. 
(Required Entry, as indicated by the blue dot.) 

• File Name – Enter a valid name for the submission 
data. Use alphanumeric characters.(Required Entry, as 
indicated by the blue dot.) File names should not 
contain more than 100 characters. Do not use 
symbols when naming the files. For example, do not 
use slashes (/)(\), tildes (~), asterisks (*), periods (.), 
brackets [ ], single quotation marks (‘), double 
quotation marks (“) or parentheses ( ). 

• Provide additional comments… – Enter any 
additional information about this report 
(Optional Entry). 
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Subsection 2.3: Creating a New Submission 

Action Graphic 

5. When you are finished entering all information in the 

fields, click Create. The first screen of your new blank 
submission report is displayed. 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

Copy an To copy an existing submission in order to create a new submission, follow the 
Existing instructions below. 
Submission to 
Create a New 
Submission Action Graphic 

1. Click File > Open. (Or, click the Open icon on the 

Tool Bar.) The Open Submission Dialog box is 
displayed (as shown below). 

Open Report 
Data Dialog 
Box 

2. Click to select the existing submission report to be used
as a template, and click Open. The submission report is 
displayed on your computer. 

3. Click File > Save As. The Save Submission As Dialog 
box is displayed (as shown below). 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

Action Graphic 

Save 
Submission As 
Dialog Box 

4. Complete the fields on this dialog box as follows: 

• Descriptive Name – Enter any descriptive name, 
as long as it is unique to the submission list. Use a 
name that distinctly identifies the report to you. 
(Required Entry, as indicated by the blue dot.) 

• File Name – Enter a valid name for the 
submission data. Use alphanumeric characters. 
(Required Entry, as indicated by the blue dot.) 

• Provide additional comments… – Enter any 
additional information about this report (Optional 
Entry). 
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Subsection 2.4: Copy an Existing Submission to Create a 
New Submission 

Action Graphic 

5. When you are finished entering all information in the 
fields, click Create. 

The first screen of your new submission report is 
displayed. 

6. Since you copied an existing submission, it already 
has many or all questions answered. You now have 
the opportunity to go through and change responses 
for this new submission. (Creating a new submission 
in this manner is convenient if you are creating a 
supplemental report or creating a report for a product 
in an existing product family.) 

7. You are now ready to change the responses in this 
submission, go to Entering Submission Information on 
page 52. 
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Subsection 2.5: Re-open an Existing Submission 

Re-open an 
Existing 
Submission 

To re-open an existing submission, follow the instructions below. 

Action Graphic 

1. Click File > Open on the menu bar. 

OR 

Click on the tool bar. 

The Open Existing Submission Dialog box is 
displayed (as shown below). 

Open Existing 
Submission 
Dialog Box 

2. Click to select (highlight) the submission that you 

wish to open, and click Open. The selected 
submission is displayed. 
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Section 3: Interface 

Contents 

This section contains the following topics: 

Topic See Page 
Application Window 35 
Toolbar 41 
Menu Bar – Output 43 
Menu Bar – Tools 44 
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Subsection 3.1: Application Window 

Introduction 

Simple View 

This section describes eSubmitter’s Application Window and its different parts. 

The eSubmitter Application Window has two layouts that change the 
orientation of the text on the screen: simple and expert. When you first start 
up the application, eSubmitter opens in the simple layout with the screen view. 

The simple view shows only the current data entry screen and “hides” the outline 
tree. The simple view separates the Submission Display Screen into three 
additional areas (as shown below): 

• Header Area (located at the top) 
• Outline Area or Screen Area (located in the middle) 
• Navigation Bar (located at the bottom), which allows forward and 
backward movement through the screens, as well as the ability to switch back and 
forth between the outline or screen view. 

Header Area 

Screen 
Area 

Navigation 

Bar 
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Subsection 3.1: Application Window 

Expert View The expert view allows the user to navigate through the form using an outline 
tree located on the left side of the screen. The expert view separates the 
Submission Display Screen into four additional areas (as shown below). 

• Header Area (located at the top) 
• Outline Area (located at the left) 
• Screen Area (located to the right) 
• Splitter Bar (located between the outline and screen areas) 

Header 

Area 

Outline 
Area 

Splitter
Bar 

Screen 
Area 
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Subsection 3.1: Application Window 

Layouts Both layouts provide the same information. It is your choice as to which layout 
works best for you. You can switch between the two layouts very easily, as 
well as customize eSubmitter to open in the expert layout. To learn how to 
change eSubmitter so that the application opens in the expert layout, rather than 
in the simple layout, see User Pre ference Tab – Layout on page 16. 

The Application Window, whether in simple or expert layout, is divided into 
three parts, as shown below. 

1. Menu Bar 
2. Tool Bar 
3. Primary Report Screen 

Menu 
Bar Tool Bar 

Primary 
Report 
Screen 

Parts of the The different parts of the Primary Work Area are defined as follows: 
Primary Work 
Area 
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Subsection 3.1: Application Window 

Header Area Displays the following general information about the open submission: 

• Submission Name – the name that you created for the report. 

• Report Type – depends on the type selected when creating the submission 
in the Create New Submission wizard. 

• Last Modified – represents the date and time the submission information 
was last saved to the disk file. The date and time are automatically updated 
after each save. 

• Date Packaged – represents the date and time the submission files were 
generated for transfer to FDA. The date and time are automatically set after 
the files are packaged for submission. 

Outline Displays tabs that organize the report into sections (as shown below). 
Area/View 

Each tab within the outline has an image to the left of its descriptive text. This 
image depicts which tab contains the section that is currently displayed within 
the screen area (i.e., the tab with the highlighted green image). 

Each section within the outline contains a folder image to the left of the section 
text. This folder image depicts the status of required information that is missing 
from within the question responses of the section. For example: 
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Subsection 3.1: Application Window 

Screen 
Area/View 

Splitter Bar 

• Green check mark indicates no required information is missing. 
• Blue question mark indicates at least one item of required information 

is missing. 
• No mark indicates that the section does not contain any required 

questions. 

Displays the questions and responses associated with the selected section in the 
outline area. There is complete flexibility in maneuvering through the screen 
area. However, questions should be answered in order. Responses to some 
questions will determine whether further questions are required or even 
applicable, which means they may become disabled. 

Some questions within the screen area may be required in order for the report to 
be considered complete. These questions are designated with a blue dot to the 
right of the question text. A complete list of required information that is 
currently missing from the report can be accessed by selecting the Missing 
Data Report option on the Output menu. 

The presence of a scroll bar on the right-hand side of the screen area indicates 
that the screen extends below the view window. To scroll down to view 
questions and messages that are below the view window, press the downward 
scroll arrow. 

Note: It is recommended that you always scroll down the entire screen to 
ensure that you have answered all questions for that screen. 

The splitter bar is the vertical bar between the outline and screens areas in the 
Expert layout, as shown below. By dragging the bar with the mouse to the left 
or right you can control the proportion of the window that is allocated to each 
of the areas. Adjusting this bar may be necessary on smaller monitors in order 
to improve readability of the text. 
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  Subsection 3.1: Application Window 

Splitter Bar 
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Subsection 3.2: Toolbar 

Introduction 

The tool bar is a row of buttons that are designed to provide quick access to 
specific or commonly used commands and options. The tool bar is located 
below the menu bar. 

Note: The screens and information that are accessed through the icons can also 
be accessed using the following menus: File, Edit, View, and Help. However, 
you must access information for Output and Tools (with the exception of 
Package Files for Submission) through the actual menus. For information 
relating to output and tools functions, refer to pages 43 and 44 respectively. 

The buttons on the tool bar are grouped by functionality and are described 
below: 

Tool Function 

New – Displays the New Submission Dialog box, which 
allows a new (empty) template to be created. 

Open – Displays the Open Submission Dialog box, which 
allows an existing template to be selected and opened. 

Save – Saves any changes within the open submission to 
permanent storage (e.g., to the disk). 

Simple Layout – Selects the simple layout, which displays 
the current data entry screen and contains basic options for 
moving forward and backward through the report one screen 
at a time. 

Expert Layout – Selects the expert layout, which contains 
the overall outline and current data entry screen side-by-side. 

Home – Takes you to the home screen. 
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Subsection 3.2: Toolbar 

Previous – Navigates to the previous screen. 

Next – Navigates to the next screen. 

Process Screen Changes – Processes your changes to screens 
without saving the submission or selecting another node. This 
option allows you to see how rules impact the form based on 
the changes made without having to leave the screen. 

Screen Undo – Undoes most recent changes made. 

Cut – Cuts text. 

Copy – Copies text. 

Paste – Pastes text. 

Package Files for Submission – Packages your submission 
to send to FDA after you have completely answered all 
required questions. For complete information, see Packaging 
Submission Files on page 92. 

Help Contents – Displays the Help Menu, which includes the 
User Manual, Quick Guide, and FAQs. 

FDA eSubmitter 
User Manual v6.0 

42 



 
 

   
 

  
  

 

 

  
 

 
 

  

 

 

 

 
 

 
 

 
 

    
     

 

 
 

 
 

   Subsection 3.3: Menu Bar - Output 

Introduction The Output menu includes commands 
related to the output of reports for 
submission information. For complete 
information on getting a submission ready 
to send to FDA, see Completing a 
Submission on page 87. 

Note: All report outputs are generated as Rich Text and require an application 
capable of viewing output, such as a WEB browser, the full version of Adobe 
Acrobat (not Acrobat Reader), or Microsoft Word. 
Each command on the Output menu is described below. 

Output Menu 
Commands 

Tool Function 

Missing 
Data 
Report 

Provides a list of required questions that you have not yet 
answered. The list is provided in Rich Text format. You can 
save the report file at any time. However, you will not be able to 
package a submission file to submit to FDA until there is no 
missing data. For complete information, see Subsection 4.5: 
Completing a Submission on page 87. 

Submission 
Report 

Views/prints out the submission report with your entries in Rich 
Text. 

Submittal 
Letter 

Provides a formatted cover letter in Rich Text for you to sign 
that identifies your file and must be submitted along with the 
CD and any hardcopy of the report (if required) to FDA. 

Package 
Files for 
Submission 

Allows you to package files for submission after completing the 
submission and verifying that there is no information missing. 
For more information on packaging files for submission, see 
Subsection 4.5: Completing a Submission on page 87. 
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Subsection 3.4: Menu Bar -Tools 

Introduction Each command on the Tools Menu is described 
below: 

Tools 

Address 
Book 

Function 

Displays the 
Organization/ 
Contact Address 
Book Dialog box, 
which provides the 
ability to maintain 
the addresses of the 
pertinent 
Organizations and 
Contacts of the 
manufacturing and 
corporate facilities 
associated with 
your reports. 

You only need to enter each organization name and address once into 
the Address Book, then select the appropriate entry in response to 
each question. If the mailing address is the same as the physical 
address, the physical address can be copied into the mailing address 
fields. If they are similar but not exactly the same, it can be copied, 
and then edited. The Address Book will always be accessible for 
future reports, and you can update it as needed. This should reduce 
confusing, misspelled, and redundant entries. 

The Organization/Contact Address Book Dialog box contains a list of 
all the available organizations and a comments area for viewing the 
comments on the selected establishment. In addition, if you scroll 
across the address list, you’ll see fields containing basic identifier 
information about each organization. 

Radio buttons control this display as by View by Organization/ 
Contact or View by Contact Only. 

The View by Organization/Contact has the options (New, Edit, 
Delete, and Close) in this dialog box are described below: 
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Subsection 3.4: Menu Bar -Tools 

New Displays the New Organization Dialog box, which allows 
a new organization to be created. Below is an example. 
Enter information in the fields to identify a particular 
organization. 

Click the Reference Numbers tab to enter the 
reference numbers associated to the organization is 
physically located. See below. 

⇒Click the Physical Location tab to enter address 
information for where the organization is physically 
located. See below. 
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Subsection 3.4: Menu Bar -Tools 

Click the Mailing Location tab to enter address 
information for the mailing address of the organization. 

Click if the mailing location is the same 
as the physical location of the organization. The 
information is automatically copied into the address fields 
(as shown above). However, if the mailing location 
differs drastically from the physical location, you must 
manually enter the information. 

When you are finished with the addresses, click 

to save your edits or click to ignore all edits. 
You return to the Organization/Contact Address 
Book Dialog box. 

Click the Comments tab to enter comment 
information for the organization. 

⇒When you click the note pad icon 

a text entry pop up is displayed. 

⇒When you are finished with the comments, click 

to save your edits or click to ignore all edits. 
You return to the New Organization Dialog box. 
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Subsection 3.4: Menu Bar -Tools 

Edit Displays the Edit Organization Dialog box, which allows the 
selected establishment information to be changed. (You enter 
information in this dialog box in the same manner as the New 
Organization Dialog box.) 

Delete Deletes the selected contact from the list. 

Tools Function 

View by Displays the 
Contact Organization/
Only Contact Address 

Book Dialog box, 
Contact Only list, 
already entered 
individually. The 
View by Contact 
Only has the 
options (Edit, 
Delete, and 
Close) in this 
dialog box are 
described below: 

Edit Displays the Edit Contact Dialog box, which allows 
the selected contact information to be changed. 

Delete Deletes the selected contact from the list. 

Close Closes the dialog box. 
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Subsection 3.4: Menu Bar -Tools 

Tools Function 

Submission Displays the Master File Attachment Dialog box, which allows you to 
File List manage the file information to be attached for use across questions in 

the submission. Default radio button is Add a New File from the 
Workstation or the Network to the List. 

Attaching PDF files requires software capable of viewing and/or 
printing PDF files (e.g., Adobe Acrobat). If you did not set your file 
viewer under User Preferences, the first time a PDF file is attached, 
the software will prompt you to locate the application within the 
system that will be used to view/print such files. Once identified, the 
software will no longer prompt for this information. For information 
on setting up your PDF Viewer, see page 21. 

Note: The file list is specific to the submission that is currently open, 
retained nor accessible for future reports. 

The Master File Attachment Dialog box manages the file attachment 
information related to the open submission. The dialog box contains a 
list of all the attached files that are currently available, an area for 
general information on the selected file, and options for managing the 
list. The file list displays the following for each: 
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Subsection 3.4: Menu Bar -Tools 

• Descriptive title 
• Physical file name 
• Number of questions that currently reference the file as an 

attachment 
• File date 
• File size 
• Path to the file location 

The options provided in the dialog box are described below: 

Add a 
New File 

Allows you to add a new file to the Master File Attachment list 
for later use as a question response. For instructions on how to 
attach files as a question response, see How to Attach a File to 
an Attachment Question Type, beginning on page 62. 

View/ 
Manage 
File List 

Allows you to manage the existing documents in the list of files 
displayed in Step 2. The options available for managing the list 
of existing files include View, Edit, Delete, and Close. These 
options are described below. 

View Displays the selected file within the specified PDF viewer. 

Edit Displays the Edit File Dialog box, which allows the selected 
file title and general description to be changed. 

Delete Deletes the selected file from the list. 

Close w/ 
Changes 

Closes the dialog box and saves the changes made to 
the Master File Attachment list. 
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Subsection 3.4: Menu Bar -Tools 

Tools 

Assign 
Submission 
ID 

Function 

Allows you to enter an FDA-related identifier to a submission. After 
you have sent the submission to the FDA for processing and if you 
have received a unique identifier, you may store that FDA assigned 
identifier in the submission for tracking purposes. For complete 
information on preparing a submission, see page 51. 

To enter a Report ID: 

 Select Assign Submission ID from Tools on the Menu bar. 
You see the Assign Submission ID dialog box (see below). 

 Enter the unique identifier assigned by FDA. 

 If you are satisfied with your entry, click OK. Or, click 

Cancel to close the dialog box without making any changes. 
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Sectio SubmissSection 4: Preparing a Submission 
Contentste 

ThisThis section contains the following topics: 

Topic See Page 
Entering Submission Information 52 
Question Types 54 
 Address and Contact Information 54 
 Option Lists 57 
 File Attachments 61 
 Guidance Documents 67 
 Text Fields and Messages 70 
 Product Codes 72 
 Standards 78 
 Sections as Tables 80 
Relationships Across Screens 81 
Saving Submission Entries or Changes 86 
Completing a Submission 87 

Completing a Submission (Packaging Submission Files) 92 
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Subsection 4.1: Entering Submission Information 

Introduction 

Entering 
Responses into 
the Submission 

Entering information for a submission requires stepping through the form and 
answering questions. If you use the simple layout, you progress through the form 
screen by screen, ensuring that you have filled in all appropriate responses. If you use 
the expert layout, you progress through the outline sections of the form, activate each 
section to load the section questions and responses, and ensure that you have filled in 
all appropriate responses. You may also use the green navigation arrows located in the 
tool bar to move through the submission in expert view. 

Note: For the purpose of this guide, all graphics are in the expert view. Also, 
information marked with a blue dot is required. 

For additional information on the simple and expert layouts, see Interface on page 34. 
It is strongly recommended that you follow the order of the sections as they are listed 
in the outline. The order has been set up to represent the most logical progression 
through the submission form. This is especially important for first-time users who are 
less familiar with the application to ensure you have filled in all appropriate responses. 

Note: It is recommended that you always scroll down the entire screen to ensure that 
you have answered all questions on the page. 

To enter responses into the submission, follow the instructions below. 

Action Graphic 

1. The eSubmitter application must be open on your 
computer desktop, and a submission must be open. If 
the application and a submission are not open, see the 
instructions beginning on page 8. 

2. Navigate through the submission as follows: 

• If you are in the simple layout, use the buttons on 
the navigation bar to advance to next/return to 
previous screen. 

• If you are in the expert layout, use the outline 
pane, and activate each section to load the screen 
or the navigation arrows located on the tool bar. 
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Subsection 4.1: Entering Submission Information 

3. Provide a response to the question(s) on the screen. 
The response required depends on the type of 
question. 

Question Types The eSubmitter tool uses several different types of questions to capture all the 

information that is required for a specific report. The response that you enter 
depends on the type of question used in your particular report. For example, to 
answer a specific question, you may be required to select a response from a 
drop-down box, type in text, attach a separate PDF file, select a check box, or 
provide contact information. 

The following subsections describe each of the different question types and 
include examples of their respective responses. 
Note: You may not see all of these types of questions in one particular 
report. The purpose of this section is to provide a brief overview of all of the 
different question types that are used in the eSubmitter software. 
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Subsection 4.2.1: Question Types – Address and Contact 

Information 

Address This question type requires that you enter the address and phone 
numbers of your organization. You enter the information in text 
fields and make selections using drop-down menus and clicking 
option buttons. An example is shown below. Other types of address 
questions are Contact and Multi-Part Address, which will be 
discussed below. 

Contact 
(Simple) 

This question type requires that you type contact information (first 
name, last name, etc.) in text fields. Entries may or may not be 
required. The figure below shows an example of a simple contact 
question with the first name, last name, and email address as 
required fields (as indicated by the blue dots). 

Contact 
(Multi-
Part) 

This question type contains multiple sections that you need to 
complete (indicated by the tabs: Contact Information, 
Establishment Identification, Physical Location, and Mailing 
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Subsection 4.2.1: Question Types – Address and Contact 
Information 

Location). For this question type, you may enter contact 
information (first name, last name, etc.) directly into text fields, or 
you may copy this information from the Contact Book. When you 
enter the information directly (without using the Contact Book), the 
contact information is only saved for the submission. Copying the 
information from the Contact Book saves time for data entry 
because the information is automatically copied into the question. 
Information in the Contact and Address Books requires that you 
only enter the data once and reuse it across multiple submissions. 

You can also copy information from the question into the Contact 
or Address Books if you have already begun filling in the question 
fields directly. 

The figure below shows an example of a multi-part contact 
question. 

Tabs 

Copy 
Information 
from Contact 
Book into 
Question 

To copy information from the Contact Book into the Contact question type, 
follow the instructions below. 

Action Graphic 

1. Click the Copy from Contact Book icon in the 
question. The Contact List Dialog box is displayed, as 
shown below. 
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Subsection 4.2.1: Question Types – Address and Contact 
Information 

Contact List 
Dialog Box 

Copy 
Information 
to Contact 
Book from 
Question 

To copy information to the Contact Book from the Contact question type, 
follow the instructions below. Note: An Establishment must be associated. 

Action Graphic 

1. Click the Copy to Contact Book icon in the 
question. The Contact List Dialog box is displayed, as 
shown below, with the entry added. 

2. Click to highlight and select the desired contact. 

3. Click Select. The contact information is automatically
populated in the different entry areas (within each
applicable tab). 

4. If the information is not exactly the same, you can edit 
the information in the question fields after you have 
copied it. 

5. To see the other information, click on the desired tab. 
If you copied the contact information from the Contact 
Book, the information for these tabs will be completed 
as well. 

6. For more information about Contact Books, see page 
54. 
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Subsection 4.2.2: Question Types – Option Lists 

Radio 
Button 

This question type requires that you click on the radio button to 
select a question response. Only one response can be selected. 
See the example below. 

Drop-
Down 
Menu 

This question type requires that you select a response from a 
list of entries that appear after you click the box with the down 
arrow ( ). Below is an example of a question with a drop- 
down menu. 

Check 
Box 

This question type requires that you click on the box to select 
or clear the check mark to answer a question. See the example 
below. 

Check 
Box 
Group 

This question type requires that you click on the box(es) to 
select or clear the check mark(s) to answer a question. Multiple 
responses can be selected. See the example below. 

Date This question type requires that you type in a date, using 
mm/dd/yyyy format as a response. See the example below. 
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Subsection 4.2.2: Question Types – Option Lists 

Date 
Range 

This question type requires that you type in a date range, using 
mm/dd/yyyy format as a response. See the example below. 

Numeric 
Spinner 

This question type allows you to use the up and down arrows to 
select a number. Alternatively, you may enter a number directly 
into the field. See the example below. 

List Item This question type allows you to select an item from a list of 
options. Below is an example of a list item question. 

Access the List To access the list of available options, follow the instructions below. 
of Available 
Options Action Graphic 

1. Click the Select Item icon. A Selection List Dialog 

box is displayed (as shown below). 

Selection List 
Dialog Box 

2. Click to select (highlight) the desired option. 
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Subsection 4.2.2: Question Types – Option Lists 

3. Click the Select button. The Selection List Dialog box
closes, and you return to the open submission with the 
list item question showing your selection (as shown 
below). 

4. If you wish to change your response, click the delete 
icon. Your response selection is deleted from the 
question. 

5. Repeat steps 1 through 3 to make another selection. 

Table This question type allows you to select from a list or add text items 
that are then placed in a table. Below is an example. 

Select multiple To select from a list of options or to enter text responses into a table question 
options or enter type, follow the instructions below. 
text responses 
into a Table 

Action Graphic 

1. Click the Add icon. 

2. You will be prompted to either select from a list of 
options or enter a response into a text field. 

3. If you wish to change your response, select (highlight) 
the option in the table and click the delete icon. The 
selection is deleted from the question list. 
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Subsection 4.2.2: Question Types – Option Lists 

Action Graphic 

4. You may have the option on some to chagne the name 

by selecting the Pencil icon 

5. Repeat steps 1 and 2 to make another selection or 
enter text responses into the table. 
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Subsection 4.2.3: Question Types – File Attachments 

File 
Attachment 

Please see Section 5 FDA Recommendations for PDF File Specifications to 
ensure you are meeting the FDA recommendations for electronic files 
submitted and archived. 

This question type allows you to attach a file as a response. The question 
may contain a text editor that allows or requires you to type additional 
information. In addition, this editor may be a Rich Text Editor, which 
allows you to format what you type (bold, underline), run spell check, or 
insert a table. You may use this area to provide descriptive information or 
clarification, such as “see page 15 of the attached user manual.” You may 
be required to enter the attachment or provide the descriptive text. 

Note that the question itself may be restricted to only allow certain file types 
to be attached (e.g., PDF only or a combination, such as PDF and/or Excel 
file types only). 

Attaching PDF files requires software capable of viewing and/or printing 
PDF files (e.g., Adobe Acrobat). The first time a PDF file is attached, the 
software will prompt you to locate the application within the system that 
will be used to view/print such files. (See below). 

Once identified, the software will no longer prompt for this information. For 
information on setting up your PDF Viewer, see page 21. 

Below is an example of a file attachment question with a response properly 
attached. See instructions for correctly attaching files in the subsequent 
section. 

Location of File 
Attachment 

Indicates Rich 
Text Editor 
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Subsection 4.2.3: Question Types – File Attachments 

How to Attach 
a File to an 

To attach a file as a response to an attachment question in eSubmitter, follow the 
instructions outlined below. 

Attachment 
Question Type 

Action Graphic 

1. Click the Add File icon to select the desired file to 
attach as the question response. The File Attachment 
Dialog wizard is displayed (as shown below). 

File 
Attachment 
Dialog Box 

2. Step 1: Select the Method for Identifying the File 
to Attach. 
In this step, choose the desired method for selecting 
the file to attach. The options are: 
1. Choose a previously attached file from the master 
list of previously attached files 

OR 

2. Select a new file from your computer or a 
network drive that has not been previously attached to 
the submission. 
Note: The wizard defaults to the method “Select a 
File from a List of Previously Attached Files” if the 
master file list contains any files to choose from. If 
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Subsection 4.2.3: Question Types – File Attachments 

there are no files in the master file list, it will default 
to the method “Select a New File from the 
Workstation or Network”. 
If you would like to navigate to a location on your 
computer and select a new file, click the radio button 
to change the response in Step 1 to “Select a New File 
from the Workstation or Network”. 

3. Step 2: Select the File to Attach According to the 

Method Chosen -- Select a Fi le from a List of 
Previously Attached Files. 
If the file can be located in the list of previously 
attached files, select (highlight) the file from the list. 

Select a File 
from a List of 
Previously 
Attached Files 

4. Once a file in the list is highlighted, the Attach 
Selected File button is activated in the bottom right
side of the dialog box. 

Click the Attach Selected File button to properly 
attach the selected file to the question response. 

5. Step 2: Select the File to Attach According to the 
Method Chosen -- Select a New File from the 
Workstation or Network. 

If the file cannot be located in the master list, then the 
method chosen in Step 1 must be “Select a New File 
from the Workstation or Network”. 

6. Step 2 of the File Attachment dialog changes to 
correspond with the method chosen (as shown below). 
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Subsection 4.2.3: Question Types – File Attachments 

Select a New 
File from the 
Workstation or 
Network 

7. Click the file folder icon to the right of the Locate 
File field. 

You will see a Select File to Attach dialog box as 
shown below. 

Select File 
Dialog Box 
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Subsection 4.2.3: Question Types – File Attachments 

8. Verify that the correct file type is selected in the Files 
of Type drop down located below the File Name 
field. Only those files of the type chosen will appear 
in the display pane for you to select. The Files of 
Type is defaulted to Adobe Acrobat Files (.pdf). 

Note: The Files of Type drop-down field may not be 
enabled if the question has been set to restrict the 
response to only allow a particular file type (e.g., PDF 
only). 

9. Click the Look In drop-down menu to locate the 
drive, such as Local Disk (C:), or folder where the file 
you wish to attach is stored. 

10. When you locate the desired file, click to select it 
(highlight). The name of the file appears in File Name 
(as shown below). 

Select File 
Dialog Box – 
File Selected 

11. Click Select. The Select File to Attach dialog box
closes, and you return to the File Attachment dialog 
box. 

12. Enter a title in Descriptive Title (required entry) and 
a description in Description of Selected File, if 
desired. 
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Subsection 4.2.3: Question Types – File Attachments 

13. Click Attach Selected File. You return to the 
submission. 

Multiple File 
Attachments 

This question type allows you to attach multiple files as a response. Below 
is an example of an attachment question with a file attachment included. In 
the image below, the green plus sign is still enabled after attaching a file, 
indicating that additional files may be attached as the response. 

To attach multiple PDF files to an attachment question, follow the same 
instructions listed under How to Attach a File to an Attachment Question 
Type beginning on page 62. 

Scroll Bar to 
view additional 
details on files 
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Subsection 4.2.4: Question Types – Guidance Documents 

Guidance 
Documents 

This question type allows you to select the guidance 
documents that you used to prepare your submission, as well 
as provides space for you to add supporting text if 
necessary. Below is an example of a guidance document 
question. 

Select a 
Guidance 
Document 

To select a guidance document, follow the instructions below. 

Action Graphic 

1. Click the Add Guidance icon. The Guidance 

Document Filter Dialog box is displayed (as shown 
below). 

Guidance 
Document 
Filter Dialog 
Box 
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Subsection 4.2.4: Question Types – Guidance Documents 

2. On this dialog box, you have several options for 
searching for a particular guidance document: 

• In the Title text box, you can type the title of the 
desired document (if you know what it is). 

• If you do not know the title of the document, 
select the applicable office from the Office list 
box. 

• On the Division list box, select the desired 
division. 

• Click Clear Filter to delete your selections and 
begin a new search. 

3. Depending on which method you used, one or more 
guidance documents will appear in the Guidance 
Documents matching the specified filter criteria 
area of the screen 

4. Use the scroll bar to see information about the found 
guidance documents. 

5. If you are connected to the Internet and have Adobe 
Acrobat installed, click to select a desired document, 
and click View Guidance to see the selection. 

6. To move a guidance document to Guidance 
Documents currently selected area of the screen: 

• Click to select (highlight) a particular guidance 
document. 

• Click Select. The selected document appears in 
Guidance Documents currently selected area of 
the screen. 

• Repeat the above two items for each desired 
guidance document. 

• Click Delete to remove a guidance document
from your selection. 

FDA eSubmitter 
User Manual v6.0 

68 



 
 

 

   

  
   

  

 

 

Subsection 4.2.4: Question Types – Guidance Documents 

7. Click OK when you have made your selections. 

You return to the guidance document question with 
your selection appearing. Below is an example of a 
guidance document question containing a response. 

Guidance 
Document 
Containing a 
Response 

FDA eSubmitter 
User Manual v6.0 

69 



 
 

 

 
  

 
 

 
 

 
 

 

 
 

 

  
 

 
 

 

Subsection 4.2.5: Question Types – Text Fields and 
Messages 

Memo 
(Multi Line 
Text) 

This question type provides an area for you to enter several 
lines of text (as shown below). 

The question may contain a Rich Text Editor which allows 
you to format what you type (bold, underline), run spell 
check, or insert a table. The tool bar for the Rich Text Editor 
will appear after you click in the text area to begin typing. 

Text, 
Single 
Line 

This question type allows you to type in text as a response. Below 
shows an example of a text question. 

Message This question type provides information to you as you 
complete a submission. You may see several different types 
of messages as you progress through your submission. 
Different examples of the message types are listed below: 

• Information Message 

• Error Message 
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Subsection 4.2.5: Question Types – Text Fields and 
Messages 

• Stop Message 

• Note Message 

• Confirmation Message 

• Warning Message 

• Missing Data Message 
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Subsection 4.2.6: Question Types – Product Codes 

Product 
Code 
(Single) 

This question type allows you to search for and then identify 
the product code that is assigned to your product or device. If 
applicable, you are able to search for the device class, device 
panel, and particular CFR section. The response to this 
question is for a single product code. Below is an example of 
a product code question. 

Note: The Product Code is specific to those filing with the 
Center for Devices and Radiological Health. 

Enter a Three-
Letter Code in 
the Product 
Code Question 

Search for a 
Three-Letter 
Code by 
Keyword 

To enter a three-letter code in the product code question, follow the instructions 
below: 

• If you know the three-letter code assigned to your product/device, enter it in 
the text field. The remaining fields are automatically filled in for you. 

• If you wish to remove your entry, click the delete icon ( ). 
• If you do not know the three-letter code, see the instructions below to search 

for the code. 
• If you are selecting a product code for a radiation emitting product and do 

not see an appropriate code, enter RZZ. 

To search for a three-letter code by keyword, follow the instructions below: 

Action Graphic 

1. Click the Select Item icon. A Product Code Filter 
Dialog box is displayed. 

FDA eSubmitter 
User Manual v6.0 

72 



 
 

  

  
 

 

  

 

 

 

       
  

 

  

Subsection 4.2.6: Question Types – Product Codes 

Product Code 
Filter Dialog 
Box 

2. Enter a keyword to search the database. You will be 
provided a list of product codes from which to choose 
in the Matching Product Codes portion of the dialog 
box. 

3. To further refine your search, if desired: 

• Click the Device Class drop-down list and make 
a selection. 

• Click the Classification Panel drop-down list 
and make a selection. 

• Click the Select Item icon ( ) next to the 
Identifier (under C.F.R. Selection) and make a 
selection. 

• Click to remove entries and start 
the search over again. 
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  Subsection 4.2.6: Question Types – Product Codes 

4. 
product/device, and click . You return to 
the submission screen and the product code question. 
The remaining fields in the product code question are 
filled in for you (as shown below). 

Click to highlight the best match to your 

Product This question type allows you to identify other product codes 
Codes applicable to the submission. Below is an example of a multiple 
(Multiple) product code question. 

Add Product 
Codes 

To add product codes, follow the instructions below: 

1. 

Action 

Click the Add Product Code icon. You see the 
Product Codes Filter Dialog box (as shown below). 

Graphic 
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Subsection 4.2.6: Question Types – Product Codes 

Product Code 
Filter Dialog 
Box 

2. Enter Product Code and Product Code Name in the 
appropriate sections. 

3. Click OK. 

Enter Multiple To enter multiple three-letter codes in the product code question, follow the 
Three-Letter instructions below: 
Codes in the 
Product Code Note: The Product Code is specific to those filing with the Center for Devices 
Question and Radiological Health. 

Action Graphic 

1. If you know the three-letter code assigned to your 
product/device, enter it in the Product Code text box. 
You see the product code/device appear in Product 
Codes matching the specified filter criteria (as 
shown below). 
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Subsection 4.2.6: Question Types – Product Codes 

2. Click Select. The product/device appears in Product 
Codes currently selected (as shown below). 

3. Repeat steps 1 and 2 to continue to add product codes. 

OR 

• If you do not know the three-letter code, see the 
instructions below to search for the code. 

OR 

• Click OK to return to the multiple product codes 
question. 

Search Multiple 
Codes by 
Keyword 

To search for multiple three-letter codes by keyword, follow the instructions 
below: 

Action Graphic 

1. Enter a keyword in Product Code Name to search the 
database. You will be provided a list of product codes 
from which to choose in the in Product Codes 
matching the specified filter criteria portion of the 
dialog box. 
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Subsection 4.2.6: Question Types – Product Codes 

2. To further refine your search, if desired: 

• Click the Device Class drop-down list and make 
a selection. 

• Click the Classification Panel drop-down list 
and make a selection. 

• Click the Select Item icon ( ) next to the 
Identifier (under C.F.R. Selection) and make a 
selection. 

• Click to remove entries and start 
the search over again. 

3. Click to highlight the best match to your
product/device, and click Select. The product/device 
appears in Product Codes currently selected. 

4. Repeat steps 1 and 2 to continue to add product codes. 

OR 

Click Delete to remove a product code from the 
selection. 

5. Click OK to return to the multiple product codes
question, which shows your selections. 
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Subsection 4.2.7: Question Types – Standards 

This question type allows you to select a standard for your 
submission from the list of recognized standards. Below is an 
example of a standards question. 

Standards 

Add a Standard To add a standard, follow the instructions below: 

Action Graphic 

1. Click the Add Standards icon. You see the Standards 
Filter Dialog box (as shown below). 

Standard Filter 
Dialog Box 

2. Enter title in Title Reference to search the database. 
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Subsection 4.2.7: Question Types – Standards 

3. To further refine your search, if desired: 

• Click the Category drop-down list and make a 
selection. 

• Click the Organization drop-down list and make 
a selection. 

• Click to remove entries and start 
the search over again. 

4. Click to highlight the best match to your
product/device, and click Select. The standard appears 
in Standards matching the specified filter criteria. 

5. When you are finished adding standards, click OK. 
You return to the standards question. 
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Subsection 4.2.8: Question Types – Sections as Tables 

Sections as Entire sections may appear as a table. This is referred to as a tabular view, follow 
Tables with a the instructions below: 
Tabbed View 

List View 

Details View 

The tabbed view format is indicated by a row of icons for add 
icon, delete icon, delete all icon, buttons for List, Detail, and Info 
buttons, and left right arrowssNew, Delete, Delete All, an up 
arrow, and a down arrow. Directly below this row of buttons is the 
actual table (as shown below). 

You also see a List and Details tabs. Click the New button to add an 
item to the table. You see a screen containing questions for you to 
answer. An example is shown below. 

To see the items in the table, click Details. If you accidentally enter a 
blank into the table, (by clicking New, not responding to any 
questions, and then clicking Details), you will see a line of colored 
blank spaces. Select the line of colored spaces and click the Delete 
button to remove the item from the table. 
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Subsection 4.3: Relationships Across Screens 

Sections as 
Tables with a 
Panel View 

List View 

List View 
with arrows 

Sections as 
Tables with a 
Panel View 

Similar to the tabbed view, in the panel view, entire sections may 
appear as a table, follow the instructions below: 

This format is indicated by a row icons and buttons Plus icon 
( ), Delete icon ( ), Delete All icon ( ), List 
button ( ), Detail button ( ), Info button 
( ), Left Arrow ( ), and Right Arrow ( )for 
previous and next items (as shown below). 

The left and right arrows, as seen below, will allow you to select a 
specific row when you have multiple entries. You can be sure that 
the appropriate row is selected as the row will be highlighted in blue 
and there will be an arrow in the right hand column. Please note the 
Item number column as this will be discussed in the List and Detail 
tab below. 

You also see a List and Details tabs. Click the Plus icon to add an 
item to the table. You see a screen containing questions for you to 
answer. An example is shown below. 

To switch between Products click on the product name to get 
display the list of products to select. 
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Subsection 4.3: Relationships Across Screens 

Detail View 

To see the items in the table, click Details. If you accidentally enter a 
blank into the table, (by clicking Plus icon, not responding to any 
questions, and then clicking Details), you will see a line of colored 
blank spaces. Select the line of colored spaces and click the Delete 
icon to remove the item from the table. 
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Subsection 4.3: Relationships Across Screens 

Relationships 
Across Parent 
and Child 
Screens 

If you have added multiple entries, you will note that in the Detail or 
in the Add New view, the Item Number, highlighted below, will 
change based on the Item Number as seen in the List view above. 

Item Number 

Some tabbed and/or panel screens may be linked together 
through a parent/child relationship, follow the instructions 
below: 

If this parent/child relationship exists, you will see a header bar 
on the child screens, as seen below, indicating which list item 
within the parent table you are currently entering data for. 
These child screens will be repeated for each list entry in the 
parent table, as necessary. 

Relationship 
Header 
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Subsection 4.3: Relationships Across Screens 

The parent/child relationship can also be seen when in expert 
view. As mentioned on page 36, the expert view allows the user 
to navigate through the form using an outline tree located on the 
left side of the screen. As seen below, the “Brand Logo and 
Registered Trademark” is a subfolder to the “List of Tobacco 
Products (By Brands) folder”. The subfolder is the child. 

Expert View 
Relationship 

Relationship 
Example 

As you enter information into the parent and child screens, the 
user will use the List view and the headers to understand the 
relationship between the data. Changing the parent screens will 
cause the child screens to change. Please see below for an 
example. 

In the expert view on the left, you see the parent folder named 
“Product and Ingredient Listing”, below, and the parent 
folder’s corresponding simple screen. 

In the right side of the screen seen above, the product category 
cigarette is selected. As you move through to the child folder 
“Sub-Brand Details (Packaging Level” and after entering the 
appropriate data, you will see the following information in the 
List view. Only the Parent in the Header is added to, to change 
that click on the parent name to see available parents and select 
the one you need. 

FDA eSubmitter 
User Manual v6.0 

84 



 
 

Subsection 4.3: Relationships Across Screens 

Once you enter information for one child, you can add more via 
the Plus icon from any of the Primary screens (Parent, 
Component, Ingredient in the above example 

Parent 
Child 

Child 
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Subsection 4.4: Saving Submission Entries or Changes 

Introduction While moving through the submission, any changes made to question responses 
are automatically updated within memory (e.g., the user made a change to a 
question response, went to another section of the submission, and returned to 
see that the changes to the response were still in effect). If you have auto-save 
turned off in Preferences, these changes are only saved permanently when you 
select the Save option from the tool bar or File menu. Therefore, follow the 
same guidance that you would use when saving data in other software. In other 
words, whenever you have entered an amount of data that would be frustrating 
to have to re-enter, select the save option. For information on changing auto-
save preferences, see page 15. 

Note: The software will remind you to save if data has been changed and you 
are about to perform an operation that would result in losing your 
changes, such as opening another submission or exiting the application. 

To save a submission, follow the instructions below: 

Action Graphic 

1. Click File > Save. 

OR 

Click the Save icon on the tool bar. 
If you do not finish entering information into a 
submission in one session, you may return to it at 
another time. See Reopening an Existing 
Submission on page 33. 

2. If you wish to close the submission, click File > 
Close. The Intro Screen is then displayed. 
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Subsection 4.5: Completing a Submission 

Introduction 

Missing Data 

To complete a submission, you must identify if any data is missing from your 
report (and then enter the required data), package the files for submission, find 
the necessary files on your computer, and copy the files onto a CD or transmit 
via the Electronic Submissions Gateway (ESG). 

You will only be able to package files for submission as long as no required 
data is missing from the submission. To determine if any data is missing, you 
will generate a Missing Data Report. To proceed, the desired submission 
should be open and displayed on your computer screen. 
Note: All report outputs are generated as Rich Text and require an application 

capable of viewing Rich Text output, such as a WEB browser, the full 
version of Adobe Acrobat (not Acrobat Reader), or Microsoft Word. 

To determine if required data is missing from the submission, follow the 
instructions below: 

Action Graphic 

1. From the menu bar, click Output > Missing Data 
Report. The Report Output Dialog box is displayed 
(as shown below). 

Report Output 
Dialog Box 
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Subsection 4.5: Completing a Submission 

2. On this dialog box: 

• Select the desired application to view the 
output in Rich Text: 

• Click the option button: Default Browser or 
Other HTML Viewer (The default setting is 
your Web Browser.) 

 If you selected Other HTML 
Viewer, the Select button becomes 
enabled. Click the Select button. 
You see the Select HTML Viewer 
Application File dialog box (as 
shown below). 

Select HTML 
Viewer 
Application File 
Dialog Box 

• Click in the Look In box to navigate to the 

executable (.EXE) of the application to view 
the HTML. For example, if you want to view 
the missing data output report in Word 2002, 
you would navigate using the following path: 

C: > Programs > Microsoft Office > Microsoft 
Office > Office 10> WINWORD.EXE 

The following screens display an example for the 
navigation sequence to find Word 2002’s executable 
(winword.exe): 

FDA eSubmitter 
User Manual v6.0 

88 



 
 

 

  

 

Subsection 4.5: Completing a Submission 

Finding Word’s Executable File (Navigation 1) 

Finding Word’s Executable File (Navigation 2) 
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 Subsection 4.5: Completing a Submission 

Finding Word’s Executable File (Navigation 3) 

Finding Word’s Executable File (Navigation 4) 

4. Click Select. You return to the Report Output Dialog 
box with your selection showing (as shown below). 

Report Output 
Dialog Box 
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Subsection 4.5: Completing a Submission 

5. Select the desired shading of the report: click the radio 
button for either Grayscale or Color. 

6. Select the desired font size: click the radio button for 
either Small Font or Large Font (which is 
approximately 10 pt). 

7. When you are finished making selections, click OK. 
The eSubmitter software generates the report in Rich 
Text, which opens for viewing in the application that 
you selected. The missing data output report will 
either state that there is no data missing or identify the 
missing data that must be entered (as shown below) 
before the files are packaged for submission. 

8. After you have verified that no data is missing from 
the submission, you are ready to package your files 
for submission. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Packaging 
Submission 
Files 

Package Files 
for Submission 

Warning 

After completing the submission and verifying that there is no information 
missing, you are ready to package the files for submission. To proceed, the 
eSubmitter application should be open, and the finished submission displayed 
on your computer screen. 

To package files for submission, follow the instructions below. 

Action Graphic 

1. Click Output > Package Files for Submission 
from the menu bar. 

2. If data is missing, see the warning (as shown 
below). 

3. If the submission has all required data, the Packaging 
Files Dialog box is displayed (as shown below). 
Within the Packaging Fi les Dialog box you will be 
prompted to move through a series of steps detailed 
below. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Packaging Files 
Dialog Box 

Step 1: This section contains a brief overview of the packaging process. Follow the 
Overview and instructions below. 
Package File 
Information 

Action Graphic 

1. Specify the submission package file name. 

➢ The Package File Name (.zip) text box 
identifies the default zip file name for the 
submission. (eSubmitter automatically 
uses the submission name for the zip file.) 
Make a note of the name for the zip file. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Action Graphic 

2. Specify the submission output location. 

i. The Package Output Location identifies the 
file folder where the zip file is located. Make a 
note of the output location. 

ii. To change the location click the file folder 
icon (as shown below), locate the desired 
location, and click Select. 

3. Click Next to proceed to Step 2: File Attachment 
Verification. 

Step 2: File 
Attachment 
Verification 

This section lists all file attachments used in the submission. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Action Graphic 

1. Check the list to ensure that all of the appropriate 
file attachments are listed (only files referenced in 
responses will be included). See above for an 
example. 

2. Check the question counts to confirm that the files 
are attached. 

➢ NOTE: If a file appears to be missing from 
the list, go to the Submission File List 
within eSubmitter (File Menu > Tools > 
Submission File List). In the Master File 
List, ensure that each file is attached to a 
question. A zero in the Question Count 
column indicates that the file is not attached 
to a specific question and therefore will not 
be included in the packaged submission. 

3. Check the file dates, size, and locations to ensure 
the correct versions of the files are provided. 

4. Click Next to proceed to Step 3 and continue 
packaging the submission. 

OR 

Click Previous to go back to Step 1. 
OR 

Cancel and exit the Package File Dialog box. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Step 3: 
Transmission 
Approach, 
Submittal 
Letter, and 
Packaging 

This section will differ based on the submission you are filing. 
If a specific step listed below does not appear in the dialog box on your screen, 
this is because it does not apply. Please skip the instructions and move to the 
next step displayed on the Packaging Fi les Dialog box. Below is an example 
of what may appear in Step 3. 
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  Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Select 
Transition 
Approach (may 
or may not be 
applicable) 

Output Submittal 
Letter (may or 
may not be 
applicable) 

Choose the selected approach to send your submission to FDA. 

➢ The first approach is the traditional CD and signed cover letter 
mailed to FDA. See below for an example. 

➢ The second approach is only to be used when sending your 
submission through the FDA Electronic Submission Gateway 

(ESG). 
NOTE: If you plan to send your submission through the ESG, 
you will need to register to use the ESG and set up an account. 
Please see FDA ESG for more information regarding the ESG. 
In addition, if the Attach Signed Submittal Letter is 

available, you must have the capability to scan your signed 

cover letter in the subsequent Output Submittal Letter step 

(see below). 

Follow the instructions below for the Output Submittal Letter. 

Action Graphic 

1. 
Click the button, as 
shown below. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

2. a. Ensure that your submittal letter is 
accurate. 

b. Print and sign the submittal letter. 

c. Prepare to mail the submittal letter 
(for CD transmission approach) 

OR 

d. Scan the submittal letter (for 
Gateway transmission approach) 
and note the location where you 
store the file (you will need to 
navigate to this location in the next 
step). 

3. Click on the folder icon (see below) to attach the 
signed submittal letter that has been scanned. 

4. Once you have located the signed cover letter, click 
Select to attach the file to the packaging dialog box. 
The signed cover letter path should appear (as 
shown below). 

Produce To produce a submission package, follow the instructions below. 
Submission 
Package 
(Always 

available) 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Action Graphic 

1. 
Click on to initiate the 
packaging of the zip file (as shown below). 

2. NOTE: Once the submission has packaged 
successfully, the status bar will indicate that the 
packaging is complete (as shown below). 

Large Very large submissions may be broken up into multiple packaged zip files. In 
Submission Size that case, the following confirmation statement will be displayed: 
Confirmation 
Message 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

3. Click Next to proceed to Step 4 to view the
transmission instructions related to your 
submission. 

Step 4: Transmit This section provides confirmation that the submission files have been 
Submission Package successfully packaged. The submission is ready to be sent to FDA. Follow 

the instructions below. 

Action Graphic 

1. Read the instructions provided. These instructions 
may vary depending on the approach selected in 
Step 3 (if the option was applicable). See below. 

Transmit 
Submission 
Package 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Printing, 
Locating, and 
Copying Files 

Locate the 
Submission 
Files on the 
Computer’s 
Hard Drive 

2. Click Done to close the Packaging Files Dialog 
box. 

OR 

Click Previous to return to Step 3. 

The following instructions do not apply if you are transmitting your submission 
via the Electronic Submissions Gateway. Please see FDA ESG for Gateway 
transmission instructions. If you are transmitting your electronic submission on 
CD, follow the instructions below: 

After packaging the files for submission, locate the packaged zip file on your 
computer and copy it onto a CD. In addition, you will need to mail the signed 
submittal letter (printed in Step 3 of the eSubmitter Packaging Submission 
Files Process). NOTE: For an OIVD submission, the truth and accuracy 
statement is part of the letter. 

To locate submission files on the computer’s hard drive, follow the instructions 
below. 

Action 

1. Use Windows Explorer to navigate to the label for the computer’s 
installed hard drive, e.g., Local Disk (C:). For example, on a computer 
with Windows 2000: 

• Open Windows Explorer. 

• Double-click My Computer to display its contents. 

• Look for the label of the computer’s installed hard drive. For 
example, (C:). 

2. Double-click on the label for the hard drive to display its contents. 

3. Navigate to and double-click on the Program Files file folder to open. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

Action 

4. Navigate to and double-click on the eSub file folder to open. 

5. Double-click on the output file folder to open. The zip file that you 
created in Packaging Submission Files appears. Do not modify the zip 
file after it is generated by eSubmitter. 
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Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

6. This step will differ based on the submission you are filing. Some 
programs accept a digital signature and submission via the Electronic 
Submissions Gateway and others require submission via CD-ROM and 
handwriting signatures. As of May 2015, the following is acceptable for 
each participating program: 
CDER Program: 
Generic Drug Facility Electronic Self-Identification: Digital signatures 
are not accepted at this time for GDUFA submissions. The CDER 
program only accepts submissions via the FDA Electronic Submissions 
Gateway. 
CDRH Programs: 
OIVD's 510(k): Digital signatures are not accepted at this time for 
OIVD 510(k) submissions. In the future, the digital signature will be 
available in conjunction with the FDA Electronic Submissions Gateway 
(ESG). 
Radiological Health Reports and Correspondence: Digital signatures 
are accepted and required when utilizing the FDA ESG to submit 
reports and correspondence. See note below regarding the FDA ESG. 
RadHealth Submissions utilizing the eSubmitter software may still also 
be burned to CD and mailed to CDRH in lieu of using the ESG. eMDR 
MedWatch 3500A Form: The eMDR program accepts digital signatures 
and utilizes the FDA ESG or transmission of the submission package. 
eMDR submissions may only be sent through the FDA Gateway. 
Medical Device ISO 13485: Digital signatures are not accepted at this 
time for Medical Device ISO 13485 submissions. However, the CDRH 
program accepts submissions via the FDA Electronic Submissions 
Gateway, as well as sending in by CD. 
eCopies: Digital signatures are not accepted at this time for eCopies 
submissions. eCopies submissions are accepted via CD and mailed to 
CDRH. 
CBER Program: 
OBRR BLA/BLS Submissions: Digital signatures are accepted and 
required for signing the necessary FDA OMB forms (Form 356h and 
Form 2567, when applicable). However, this CBER program does not 
accept submissions via the FDA Electronic Submissions Gateway at 
this time. 

FDA eSubmitter 
User Manual v6.0 

103 



  

 
 

 

 
 

 
 

 
 

  
 

Subsection 4.6: Completing a Submission (Packaging 
Submission Files) 

ICSR Adverse Event Reporting: Digital signatures are accepted and 
required when utilizing the FDA ESG for transmission of the submission 
package. 
CTP Program: 
Tobacco Product Ingredient Listing, Health Data Submissions, and 
other CTP submission types not listed: Digital signatures are accepted 
and required when utilizing the FDA ESG to submit ingredient listing 
and additional health data. Submissions utilizing the eSubmitter 
software may still also be burned to CD and mailed to CTP in lieu of 
using the ESG. 
Harmful and Potentially Harmful Constituents (HPHCs): Digital 
signatures are accepted and required when utilizing the FDA ESG to 
submit. HPHC submissions utilizing the eSubmitter software may still 
also be burned to CD and mailed to CTP in lieu of using the ESG. 
CVM Program: 
ONADE: Digital signatures are accepted and required when utilizing 
the FDA ESG to submit eSubmitter electronic submissions to CVM. 
OSC DER: Digital signatures are accepted and required when utilizing 
the FDA ESG to submit eSubmitter electronic submissions to CVM. 

For additional information, please refer to the eSubmitter Quick 
Guide PDF in the “Packaging and Transmission Guidelines for 
Participating eSubmitter Programs” section. 
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Section 5: FDA Recommended PDF File Specifications 

Introduction 

Recommended 
PDF File 
Specifications 

Regulations in 21 CFR Part 11 require that the Agency be able to generate from 
any document provided in electronic format an accurate and complete paper 
copy that is both legible ("human readable") and suitable for inspection, review, 
and copying. Therefore, documents submitted in electronic format should: 

• Enable the user to easily view a clear and legible copy of the information 
• Enable the user to print each document page by page, as it would have 

been provided in paper, maintaining fonts, special orientations, table 
formats, and page numbers 

• Include a well-structured table of contents and allow the user to navigate 
easily through the submission 

• Allow the user to copy text and images electronically into common word 
processing documents 

To achieve the above goals, you should submit all electronic documents in 
Portable Document Format (PDF). PDF is an open, published format created by 
Adobe Systems Incorporated (http://www.adobe.com). You do not need to use a 
product from Adobe or from any specific company to produce your PDF 
documents. PDF has been accepted as a standard for providing documents in 
electronic format by the International Conference on Harmonization (ICH). 

The following recommendations will help you create PDF files with the 
appropriate specifications to ensure that we can review and archive the 
electronic file attachments. 
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Section 5: FDA Recommended PDF File Specifications 

PDF Area Recommended PDF Specification 

Version The PDF files must be compatible with Adobe Acrobat 5.0 or greater without 
the use of additional plug-ins other than those provide by Adobe as part of 
Acrobat. We should not need any additional software to read and navigate the 
PDF files. There are features in Adobe Acrobat 8.0 that cannot be supported. If 
you would like to submit Adobe Acrobat 8.0 files, please contact technical 
support at esubmitter@fda.hhs.gov to ensure you do not use a feature that is 
unsupported. 

Plug Ins It is acceptable to use plug-ins to assist in the creation of a submission. 
However, the review of the submission should not require the use of any plug-
ins other than any provided by Adobe as part of Acrobat, and must be 
compatible with Adobe Acrobat 5.0 or greater. 

Page Size The print area for pages should fit on a sheet of paper that is 8.5 inches by 11 
and inches. You should allow a margin of at least 1.5 inch on the left margin and 1 
Margins inch on all other sides to avoid obscuring information if the pages are 

subsequently printed and bound. 
Page Pages should be properly oriented. For example, you should set the page 
Orientation orientation of landscape pages to landscape prior to saving the PDF document 

in final form to ensure correct page presentation. Landscape pages (including 
tables) should be oriented such that the header and footer of the document align 
with the right edge of the page. 

Fonts PDF viewing software automatically substitutes a font to display text if the font 
used to create the text is unavailable on the reviewer’s computer. Font 
substitution can affect a document’s appearance and structure, and in some 
cases it can affect the information conveyed by a document. We cannot 
guarantee the availability of any one font. Therefore, you should embed all 
fonts you are using in the PDF files to ensure that those fonts will always be 
available to the reviewer. When embedding fonts, all characters for the font 
should be embedded (not just a subset of the fonts being used in the document). 
One problem associated with embedding fonts is that embedding requires 
additional computer storage space. Three techniques to help limit the storage 
space taken by embedding fonts: 

• Limit the number of fonts used in each document 

• Use only True Type or Adobe Type 1 fonts 

• Avoid customized fonts. 
Resizing a document because the contents are too small to read is inefficient. 
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Section 5: FDA Recommended PDF File Specifications 

We believe that Times New Roman, 12-point font, is adequate in size for 
reading narrative text. This is the preferred font. Although sometimes tempting 
for use in tables and charts, fonts smaller than 12-points should be avoided 
whenever possible. We recommend the use of a black font color. 

Blue font may be used or hypertext links. If a font color other than black is 
used, avoid light colors that do not print well on grayscale printers. It is 
advised that you test the color reproduction prior to submission by printing 
sample pages from the document using a grayscale printer. 

In addition to font colors, keep formatting simple in tables. When extracting a 
table from the PDF document, the use of light or white font color will not allow 
the transfer of text back into some word processing documents. 

Page If a submission includes more than one document, you need not provide 
Numbering pagination for the entire submission. Include page numbers only for individual 

documents. 

It is easier to navigate though an electronic document if the page numbers for 
the document and the PDF file are the same. To accomplish this, the initial 
page of the paper document should be numbered page 1. 

File Size An electronic submission can have one or multiple file attachments. There is 
not a limitation of the total size of the submission, but each file should be 
limited to 50MB in file size. There are several ways to compress file size, 
including but not limited to: performing Optical Character Recognition, 
reducing file size in Adobe and creating logical section breaks. 
If you have questions about file size, please contact technical support at 
esubmitter@fda.hhs.gov to ensure the file size is acceptable. 

Document 
Properties: 
Description 
Tab 

Document properties are used to search for individual documents and to 
identify the document when found. To modify document properties, from the 
tool bar navigate to File Document Properties. 

Document 
Properties: 
Initial View 
Tab 

In the Document Properties box, the Initial View tab can also be found. In the 
Document Options section, all PDF files should set the Show field as 
Bookmarks Panel and Page. If there are no bookmarks, set the initial view as 
Page only. Set the Page Layout and Magnification fields to default. 

Document 
Properties: 
Security 

PDF files are stored as original documents and will not be altered from their 
original form. Remove any security settings, read-only, or password protection 
used on the files. Files submitted with security settings will not be accepted. 
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Section 5: FDA Recommended PDF File Specifications 

Indexing Full text indexes are used to help find specific documents and/or to search for 
PDF text within documents. When a document or group of documents is indexed, all 
Documents words and numbers in the file and all information stored in the Document 

Information fields are stored in special index files that are functionally 
accessible using the search tools available in Acrobat. 

Portions of a document that are imaged are not indexed. Even if the document 
only contains images, the text in the Document Information fields of the file 
will be indexed. All PDF files should be full-text searchable prior to submitting 
to the FDA. 

Bookmarks Bookmarks and hyperlinks should be used to assist the reviewers in navigating 
and through the content of the submission. If you used either bookmarks or 
Hypertext hypertext links, consider the following: 
Links 

• Use meaningful bookmarks (e.g., the title of the section, name of a 
study, data set, or facility). This will aid the reviewer in locating 
information and navigating the submission. 

• Bookmark references can be created for the heading of a section, 
subsection or title of figures and tables within the document. In general, 
including a bookmark to the main table of contents for a submission or 
item is helpful. Make the bookmark hierarchy identical to the table of 
contents. 

• Use hyperlinks within the file. Hyperlinks are used to improve 
navigation through PDF documents and are encouraged. Hyperlinks can 
be designated by rectangles using thin lines or by blue text or you can 
use invisible rectangles for hypertext links in a table of contents to 
avoid obscuring text. Hyperlinks throughout the body of the document 
to supporting annotations, related sections, references, appendices, 
tables, or figures that are not located on the same page are helpful and 
improve navigation efficiency. When creating bookmarks and 
hyperlinks, the magnification setting should be set to Inherit Zoom so 
that the destination page displays at the same magnification level that 
the reviewer is using for the rest of the document. 

Important Note: Hyperlinks between individual PDF document files are not 
currently supported and any absolute links that reference across files will not 
work. 

In general, for documents with a table of contents, provide bookmarks and 
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Section 5: FDA Recommended PDF File Specifications 

Optical 
Character 
Recognition 

hypertext links for each item listed in the table of contents including all tables, 
figures, publications, other references, and appendices. These bookmarks and 
hypertext links are essential for the efficient navigation through documents. 

PDF documents produced by scanning paper documents are usually inferior to 
those produced from an electronic source document such as MS Word. 
Scanned documents are more difficult to read and do not allow the reviewers to 
search or copy and paste text for editing. The use of scanned documents should 
be avoided if at all possible. If scanning cannot be avoided, the following is 
highly recommended: 

• Perform optical character recognition (OCR) on all scanned documents 
so that the text is searchable 

• Check to see that the content has been correctly converted. 

If the source document is only available on paper, it should be scanned at 
resolutions that will ensure the pages are legible both on the computer screen 
and when printed. At the same time, remember to limit the file size to be less 
than 50MB. We recommend scanning at a resolution of 300 dots per inch (dpi) 
to balance legibility and file size. We discourage the use of grayscale or color 
because of file size. After scanning, avoid re-sampling to a lower resolution. 

For files with images and photographs: 

Also, when creating PDF files containing images, you should not 
resample images. Re-sampling does not preserve all of the pixels in the 
original. For photographs, the image should be obtained with a 
resolution of 600 dpi. If black and white photos are submitted, consider 
8-bit gray scale images. If color photos are submitted, consider 24-bit 
RGB Color Model images. A captured image should not be subjected to 
non-uniform scaling (i.e., sizing). 

Files with scanned images and photographs tend to be large in file size. 
Please do not exceed 50MB for a single file. Consider multiple files for 
these types of documents. 

Note: Scanned tables and graphs cannot be extracted easily if scanned. 
Most OCR programs will distort the data in tables and graphs. Convert 
MS Word documents to PDF, as this method usually retains the 
formatting. 

For a paper document with handwritten notes: 

Paper documents containing handwritten notes should be scanned at 300 
dpi. These handwritten notes should be made in black ink for clarity. 
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Section 5: FDA Recommended PDF File Specifications 

If you have questions about creating electronic copies, please contact technical 
support at esubmitter@fda.hhs.gov to ensure that the format is acceptable prior 
to developing your submission. 

We are recommending names for folders and selected files in individual Naming 
guidances for specific submission types. For uniformity, we hope that you use 
our specific naming conventions when they are provided. Reviewers are 
trained to look for these folders and files, and using the recommended names 
should help avoid misunderstandings, improve communication, and speed the 
review of a submission. 

PDF Files 

File names should not contain more than 250 characters. Do not use 
punctuation, spaces, or other nonalphanumeric symbols in file names 
when naming the files for attachments. For example, do not use slashes (/) 
(\), tildes (~), asterisks (*), periods (.), brackets [ ], single quotation marks (‘), 
double quotation marks (“) or parentheses ( ). Once the file is attached to a 
question, it can be selected as an attachment to other questions, if appropriate. 

The eSubmitter tool supports the following file types: 

• Portable Document Format Files (.pdf) 
• Excel Files (.xls, .csv) 
• SAS System XPORT Files (.xpt) 
• Media Files (.wmv, .avi) 
• Image Files (.gif, .tif, .jpg) 
• Extensible Markup Language Files (.xml, .dtd) 
• Archive/Compressed Files (.zip) 
• Standard Generalized Markup Language Files (.sgml) 
• MDL Molfiles Files (.mol) 

However, based on the application or report you are submitting, the question(s) 
may have restrictions on which file types you are allowed to attach. For 
example, some questions may allow you to attach any of the file types 
supported be eSubmitter and some may only allow you to attach PDF and 
Excel files as the questions response or supporting documentation. 

FDA eSubmitter 
User Manual v6.0 

110 

mailto:esubmitter@fda.hhs.gov


 
 

 

 

 

 

Section 6: FDA User Support 

Introduction For technical assistance for the eSubmitter software, an email can be sent 
to esubmitter@fda.hhs.gov. In the email, please be sure to provide the company 
name and contact information where a response can be sent. 

For CBER - OBRR regulatory questions, please contact: 
CBER_eSubmitter_program@fda.hhs.gov or your Consumer Safety Officer 

For CBER-ICSR questions, please contact: 
CBERICSRSUBMISSIONS@fda.hhs.gov. 

For CDRH - eCopies 
For eCopy technical questions, please contact: cdrhesub@fda.hhs.gov. 
For eCopy regulatory questions, please contact: CDRH-eCopyinfo@fda.hhs.gov. 

For CDRH - eMDR regulatory questions, please contact: 
eMDR@fda.hhs.gov. 

For CDRH - In Vitro Devices and Radiological Health For regulatory 
questions, contact the Division of Industry and Consumer Education 
(DICE at dice@cdrh.fda.gov. 

For CRDH technical questions, please contact cdrhesub@fda.hhs.gov. 
1-800-638-2041 

For CTP - Guidances or the Tobacco Control Act questions, please contact 
TobaccoIndustryQuestions@fda.hhs.gov. 1-877-CTP-1373 

For CVM related technical support or general inquiries, please contact: 
cvmesubmitter@fda.hhs.gov. 
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